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Notice to Users
EasyRecovery™ is a software application that has been developed, licensed and
copyrighted by ONTRACK Data International, Inc. Use of the software is
governed by the terms and conditions of the end user license agreement contained
within the software.

This manual should not be construed as any representation or warranty with
respect to the software named herein. Occasionally, changes or variations exist in
the software that are not reflected in the manual. Generally, if such changes or
variations are known to exist and affect the product significantly, a release note or
README file will accompany the User's Guide and/or the distribution CD-ROM,
or will be available with EasyUpdate downloads. In that event, please read the
release notes or README file before using the product.

Trademarks
McAfee is a trademark of Networks Associates, Inc. in the United States and

 other countries.

Ontrack, EasyRecovery, Remote Data Recovery, Crisis Center and EasyUpdate
are trademarks or registered trademarks of ONTRACK Data International, Inc. in
the United States and/or other countries. All other trademarks used herein are the
property of their respective owners.

Copyrights
© 2003 Networks Associates Technology, Inc. All Rights Reserved. 

No part of this publication may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into a language or computer language, in any form
by any means, electronic, mechanical, optical, chemical, manual or otherwise,
without the express written consent of Networks Associates Technology, Inc.

Printed in the USA
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ABOUT THIS MANUAL

This manual uses a number of conventions that make it easier to
read and understand.

� This font denotes button and field names.

� This font denotes menus and menu paths.

� This font denotes file names, such as C:\my documents\newfile.

1. You will see this 123 graphic any time there are
numbered steps or instructions.

Notes contain additional information that may not
directly relate to the current text, but is important
to know.

Warnings contain important information that you
must be aware of to avoid possible system problems.
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GETTING HELP

THIS MANUAL

This manual will get you started installing and using
EasyRecovery. It provides an introduction and explanation of the
tools in EasyRecovery, and describes how to use each one.

ONLINE HELP

The EasyRecovery online help system is available in the following ways:

� From the Help menu, select Help Topics.

� Press the F1 button.

� In any dialog box, click on the Help button.

MCAFEE WEB SITE

At the McAfee Web Site, you can send e-mail to our customer
support team or order other McAfee products.

us.mcafee.com

TECHNICAL/CUSTOMER SUPPORT

For technical support, please visit

 http://www.mcafeehelp.com/. Our support site
offers 24-hour access to the easy-to-use Answer

Wizard for solutions to the m
common support

 questions.
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Chapter 1: Welcome to EasyRecovery

WELCOME TO EASYRECOVERY
TM DATA RECOVERY

SOFTWARE!
EasyRecovery™ Professional Edition data recovery software will help
you quickly and easily recover lost or inaccessible data.

It can help recover lost data when a drive has been:

� Hit by a computer virus

� Formatted or fdisked

� Accidentally deleted

� Zapped by a power failure or power surge

� Damaged due to rogue applications or system malfunction

EasyRecovery can help if you have corrupt or missing:

� Master Boot Record (MBR)

� BIOS Parameter Blocks (BPB)

� Partition Tables

� File Allocation Tables (FAT) (for DOS/Win9x/Me)

� Master File Tables (MFT) (for WinNT/Windows 2000)

� Root Directory

TM
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EasyRecovery is NON-DESTRUCTIVE and READ-ONLY. It will not
put any data onto the file system (volume) it is recovering from. It will
recover your data and copy it to another destination—a removable drive,
another hard drive, a floppy diskette or a network volume.

EasyRecovery is easy to use. The software’s fully automated wizard will
walk you through three simple steps:

1. Evaluate – the software identifies all devices and partitions on the
system and presents a graphical representation of what was found.

2. Recover – the software examines the file structures that remain on
the corrupted partition and constructs a virtual file system in memory
with them.

3. Tag and Copy – a list of files is graphically presented. You then
select (tag) files and folders for backup and move the data to a safe
location.

EasyRecovery Professional Edition runs in Windows 95, 98, Me, NT and
2000. It also includes a program to create an emergency boot diskette that
runs in DOS, so you can recover data even if you cannot boot to
Windows.

Be aware of strange noises coming from your hard drive as
this might be an indication of a more serious problem.
Continuing to operate your system may damage your hard
drive beyond repair or cause irretrievable data loss. We
recommend performing a disk drive diagnostic (included
with EasyRecovery) before attempting to recover any data.
If you need additional help, see the Technical Support and
Data Recovery Services, on page 7 for contact information.
Page 2
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ABOUT THIS GUIDE

This User’s Guide and the online help files will help you with the data
recovery process. See “Important Terms” on page 35 for definitions of
terms used throughout this manual.

DATA RECOVERY BASICS

While it can pull up files that have been inadvertently deleted from your
computer, EasyRecovery is more than a simple file undeleter. Even if
your computer has severe file system corruption, EasyRecovery can
locate, recover and restore your data.

When you delete files from your computer, they’re not really gone
forever. Traces of structural information are left behind on the disk itself.
EasyRecovery uses sophisticated pattern recognition technology to put
the right pieces of data together again. EasyRecovery finds those traces
and rebuilds them based on their statistical properties. It then builds a
virtual file system in memory and displays all the files, folders—even
whole partitions—it finds. Even disks with very little administrative
information can still recover files of high quality.

SUPPORTED FILE SYSTEMS

EasyRecovery can retrieve data from these file systems:

Operating System File Systems Used

PC Floppy disks FAT12

DOS FAT16 only

Windows 3.x FAT16 only

Windows 95/98/Me FAT16 or FAT32
P
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EasyRecovery Professional Edition can also retrieve data from SCSI hard
drives, and Iomega Zip and Jaz removable disks.

SYSTEM REQUIREMENTS

EasyRecovery has the following minimum system requirements:

� 486 or Pentium-class processor

� 16 MB RAM (in most cases)

� DOS, Windows 3.x, 95, 98, Me, NT or 2000

� 5 MB of free space (Windows version only)

INSTALLING EASYRECOVERY

WINDOWS VERSION

Run setup.exe from the EasyRecovery CD-ROM (or, if you downloaded
EasyRecovery, run the downloaded setup file from Windows Explorer) to
begin the installation process. If you have an Internet connection, we
recommend you check for any updates using EasyUpdate..

Windows 2000 FAT 16, FAT32 or NTFS

Windows NT 3.x or 4.x FAT 16 or NTFS

You should not install EasyRecovery on the partition you are
trying to recover (doing so may result in overwriting
recoverable files). If your system has one drive with one
partition, or if the system is not bootable, use the DOS
version of EasyRecovery.
Page 4
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DOS VERSION

Boot the computer to the EasyRecovery Emergency Boot Diskette and the
software will automatically load. We recommend you have the
destination drive ready and configured before running EasyRecovery.

MAKING AN EMERGENCY BOOT DISKETTE

Once you’ve installed EasyRecovery for Windows on a working system,
you have the ability to make an emergency boot diskette should you need
it in the future. The diskette will allow you to run EasyRecovery software
even if you cannot boot to Windows. Should the partition on which
EasyRecovery is installed become damaged in the future, you can use this
disk to recover data from that partition. To make an emergency boot
diskette, follow these steps:

1. Put a blank, formatted 3.5” floppy disk in the A: drive. If there is
data on the disk, it will be deleted.

2. From Windows, select Start�Programs�
EasyRecovery�Make Emergency Boot Diskette

3. Follow the prompts to start the process. Click OK to begin making
the disk.

4. A progress bar will appear, telling you that the files are being copied.
You can click Cancel to stop the process.

5. When all the necessary files have been copied to the floppy disk, a
new window will come up. Click Exit to return to Windows.

6. Label the disk EasyRecovery Emergency Boot Diskette.

To test the disk, shut down your computer. Turn it back on. You should
see an EasyRecovery screen instead of Windows.
P
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UPDATING YOUR SOFTWARE (EASYUPDATE
TM)

McAfee periodically improves EasyRecovery software—adding
features and making changes based on customer requests. Programming
updates (also known as patches) are also available to you through the

Internet. EasyUpdate
TM

downloads and installs program patches in
minutes.

If there are multiple components for updating, EasyUpdate provides you
with a list of options—you can update everything, or select a subset of
options.

We recommend running EasyUpdate as soon as you purchase and install
EasyRecovery, just in case there is a program patch that was not included
with your version.

To run EasyUpdate:

1. Make sure you are connected to the Internet, via modem or network.

2. Start EasyRecovery.

3. From the EasyRecovery Welcome screen, go to the EasyUpdate
menu and select Check for Update.

4. In the EasyUpdate window, click Next to continue.

This connects you to the McAfee update server. You will see a
list of the items available for download. Selected items will be
downloaded to your computer.

5. Continue to follow the instructions to download and then install the
new software.

6. When finished, click Done to exit EasyUpdate.

You may be prompted to restart Windows. Once you have restarted
Windows, the changes will appear in EasyRecovery the next time you run
it.
Page 6
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REMOVING EASYRECOVERY

To remove EasyRecovery:

1. Make sure the program is closed.

� From Windows, select
Start�Programs�EasyRecovery�Uninstall EasyRecovery.

� Confirm your decision by clicking Yes, remove EasyRecovery.

TECHNICAL SUPPORT AND DATA RECOVERY SERVICES

For technical support, please visit

 http://www.mcafeehelp.com/. 
Our support site offers 24-hour access to the easy-to-use Answer

Wizard 
for solutions to the most common support

 questions.
P
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Chapter 2: Evaluating the System and
Recovering Your Data

The first step in recovering your data with EasyRecovery is to identify
and evaluate your system. Some of this is done automatically, but you
will need to confirm some information about your computer before the
recovery begins.

SELECTING THE PARTITION TO RECOVER

When EasyRecovery loads, you’ll see the Welcome screen. Click Next to
display the System Overview page. You’ll see your hard drive(s) and
Page 8
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removable drive(s) in the window, with all partitions listed underneath. If
there’s a floppy disk in the drive, it will also be listed.

EasyRecovery can do a quick scan of your drive to determine whether
data is immediately recoverable. Go to File�Disk Diagnostics to scan
your drive. The next section, “Disk Diagnostics,” covers this feature in
detail.

Click on the partition where the data you want to recover is located and
then the Next button to continue. If the partition you want to recover is
not listed, select any partition listed under the “right” physical drive. That
is, if you want to recover the D partition on the first hard drive, and you
see just one partition, select it. If EasyRecovery detected the file system
P
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type correctly, this will take you to the Partition Information screen. If the
file system type was “unknown,” this will take you to the Partition Finder
screen (See “Changing the Partition Information (Partition Finder)” on
page 16..)

DISK DIAGNOSTIC

EasyRecovery can bail you out of the most common data loss problems,
but occasionally a partition has become so severely damaged that you
need more sophisticated techniques to get your data back.
EasyRecovery’s Disk Diagnostic can tell you where you stand even
before you’ve started the recovery process.

Go to File�Disk Diagnostic from the System Overview screen to scan
your hard drive. EasyRecovery will look for damaged sectors on the
drive for 90 seconds. If it finds more than 10 bad sectors during that scan,
it is very likely you will need professional data recovery services. If your
computer fails the diagnostic, see Technical Support and Data Recovery
Services, on page 7 for round-the-clock data recovery service phone
numbers.

When the diagnostics complete, click Back to return to System Overview.

DEFINING THE PARTITION

EasyRecovery uses information from the master boot record, any
extended boot records and BIOS parameter blocks to identify the size, file

EasyRecovery cannot recover data from a USB (Universal
Serial Bus) removable drive. Your EasyRecovery
Emergency Boot Diskette will not work if this type of drive is
damaged.
Page 10
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system, and starting and ending sectors of the partition you want to
recover.

In general, unless you are certain that something in the Partition
Information screen is wrong, clicking the Next button is the safest thing
to do. Situations where you should manually change the settings
include:

� If you know what the machine’s file system is, and EasyRecovery
reports it as something else.

� If the partition size is substantially different from what you know to
be true.

� If you have recent information on the starting or ending sector of
the partition that is different from what EasyRecovery reports.

Once you’ve set your options, click Next to begin the recovery scan.
Depending on the system’s speed, the size of your drive and the amount
of work EasyRecovery has to do, this can take from 15 minutes to
several hours.

If the information displayed is not correct, use the Change button to
correctly identify the partition to be recovered. See “Changing the
Partition Information (Partition Finder)” on page 16..
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ADVANCED TUNING OPTIONS

The Advanced Options button on the Partition Information screen allows
you to configure how the Professional Edition of EasyRecovery will
perform the recovery scan. They include:

� Specifying a good copy of the File Allocation Table for FAT file
systems

� Specifying whether or not to use the Master File Table on NTFS
systems

� Telling EasyRecovery how to handle incomplete or corrupt data files

� Whether EasyRecovery should ignore bad characters in file names
Page 12
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SPECIFY FAT COPY

In FAT-based file systems (DOS and Windows 9x/Me), data is stored in
distinct clusters on the drive. DOS creates a File Allocation Table (FAT)
to track where each file is stored. It also makes a backup copy of the FAT
in case one is damaged. By default, EasyRecovery will compare the two
copies of the FAT sector-by-sector and use the best information from each
FAT to try to recover files. If this method fails to locate the data you need,
this option allows you to choose to base the recovery scan on one or the
other copy of the FAT. The options in the drop-down menu include:

Use FAT1: Use the first copy of the FAT.

Use FAT2: Use the second copy of the FAT.

Use Best Match: The default, described above.

Ignore FAT: On occasion, both copies of the FAT are damaged. This
option forces EasyRecovery to rely solely on the information in the file
without referencing either copy of the FAT.

USING THE MASTER FILE TABLE (WINDOWS NT/2000)

Instead of using multiple copies of FAT to track the drive location of
specific files, the NT File System (NTFS) builds information on file
locations in each cluster. In addition, a record about the file is created in
the Master File Table (MFT). This record is used to locate a file's
possibly scattered clusters.

This option lets you choose whether to use the Master File Table or ignore
it during the data search. Select from the drop-down menu.
Pa
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INCOMPLETE AND CORRUPT DATA TYPES

The EasyRecovery file search by default will try to identify as many files
as can possibly be recovered. This can bring up a number of corrupt,
deleted and other files that are not relevant to you. Advanced Options
allow you to skip certain incomplete or corrupt file types. This will speed
up the scanning process. Simply uncheck the box for the appropriate
item:

Recover Files with Bad Dates: If a file date is not a number, is after
today’s date or is otherwise wrong, unchecking this box will stop
EasyRecovery from identifying this file as recoverable.

Recover Files with Bad Attributes: Unchecking this box will prevent
recovery if attributes have been damaged.

Recover Files with Invalid File Sizes: If the size of a file is reported as
larger than the volume size, unchecking this box will prevent its recovery.

Recover Files that were Deleted: Files that have been deleted but
haven’t been overwritten will be recovered by EasyRecovery. This
category can include hundreds of temporary files, deleted web cache and
history files and other irrelevant data. Unchecking this box will prevent
that from happening.

Recover Files with Bad Characters in their Name: When a file is
damaged, it can often place invalid characters in the file name. By
default, EasyRecovery locates and recovers as much data as possible.
You can use the Advanced Options to tell EasyRecovery not to recover
files with invalid characters by unchecking this box. Invalid characters
are identified with an X in the following chart. All standard alphanumeric
letters are valid. Some characters that are invalid in standard DOS 8.3 file
names are valid in 32-bit Windows long file names.
Page 14
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Character DOS 8.3 Win32

! (exclamation)

“ (double quotation mark) X X

$ (dollar sign)

% (percent)

& (ampersand)

‘ (single quotation mark)

(

)

* X X

+ X

, (comma) X

- (hyphen)

. (period)

/ (forward slash) X X

: (colon) X X

; (semicolon) X

< X X
Pa
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CHANGING THE PARTITION INFORMATION (PARTITION

FINDER)

When you click the Change button from the Partition Information screen,
you can manually configure where EasyRecovery should search for your
missing or damaged file system. This is meant to save you time and is

= X

> X X

? X X

@

[ X

\ (backslash) X X

] X

^

_ (underline)

‘

{ (left brace)

| (pipe) X X

} (right brace)

~ (tilde)

Character DOS 8.3 Win32
Page 16
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used only as an approximation. EasyRecovery will search this area
exhaustively for your file system.

There are two parts to the Partition Finder: specifying the region to
search, and identifying the file system. These are explained further in the
next two sections. These tools give EasyRecovery the minimum
information it needs to locate and recover your data.

If EasyRecovery cannot identify the file system based on the information
it finds on the drive, you will also see this screen. EasyRecovery cannot
complete a scan unless it knows how the partition is organized. If you
don’t know what file system the partition uses, there is no harm in
guessing. Use the Supported File Systems table on page 3 to help you
decide. If EasyRecovery cannot locate any files, it will simply send you
back to this screen to try again. Your files will not suffer any further
damage.
Pa
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SETTING THE STARTING AND ENDING SECTOR

The first Partition Finder screen asks you to define where to search for the
start or end of a partition. By default it will search the entire drive.

This screen offers a slider bar to reset the sector information. Just drag
the left end to the right to adjust the Starting Sector. Drag the right end to
the left to adjust the Ending Sector. You can also type this information in
yourself. EasyRecovery will search between the specified sectors to
locate the partition on the drive.

If you only know the size of your partition, and/or aren’t comfortable
using the slider bar, use the Hint button. This allows you to more easily
Page 18
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determine the location of a partition on a multiple partition system where
the relative size of each partition is known. For more on this feature, see
“Hint button” on page 25.

You can also use the Advanced Options from this screen to identify the
cluster size, the first data sector and the first cluster of the root directory.
See Identifying a Partition: Advanced Options, on page 26.

Click Next to identify the file system and set the scan mode. Click Back
to return to the Change Partition Information screen without saving your
changes.
Pa
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IDENTIFYING THE FILE SYSTEM

EasyRecovery uses information from the master boot record, any
extended boot records and BIOS parameter blocks to identify the file
system of the partition you want to recover. If that information is faulty
or unavailable, EasyRecovery will report the File System Type as
Unknown. If EasyRecovery misidentifies the file system, you can also
click the drop-down File System Type menu here.

Before EasyRecovery can analyze the partition for recoverable data, you
must select a file system.
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When you’ve made your changes, click Next to confirm the changes and
begin the recovery scan. EasyRecovery will first re-identify the partition,
then scan the drive. Depending on your system’s speed, the size of your
drive and the amount of work EasyRecovery has to do, this can take from
a few minutes to several hours.

If you want to restore the default settings, click the Back button. Click
Cancel to close EasyRecovery.

RAW SCAN

If you’ve only recovered some files, but still need some files that
EasyRecovery did not locate on the first pass, you can also select the
RAW format. This scan will read all sectors on the disk sequentially
(sector-by-sector).

This scan will only recover small files that are stored in one cluster or
larger files stored in consecutive clusters on the disk. If you have used a
disk defragmenter recently, your chances of recovering files from a badly
damaged disk are much improved.

PROFESSIONAL EDITION OPTIONS

The EasyRecovery Professional Edition offers you more ways to identify
and scan your disk.

DO NOT attempt to defragment a damaged partition before
using EasyRecovery. If your File Allocation Table is bad,
defragmenting the partition could make your files
unrecoverable.
Pa
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DISK VIEWER

The Disk Viewer is a version of the same tool Ontrack Data Recovery
Engineers use to confirm the presence of file system information and/or
data in the lab. This option allows you to view the physical hard disk on a
sector by sector basis. You can use this to perform your own manual
assessment of the system. With the Disk Viewer, you can view the
contents of specific sectors, search for text strings and display the results
in several different formats.

You can open the Disk Viewer from the Partition Finder screen. When
you launch the Disk Viewer, you’ll see the first sector of the partition
Page 22
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that’s defined as Starting sector. The disk viewer will then let you roam
the entire disk.

This is shown in Byte view: you see a series of columns of binary
numbers followed by a wider 16-character column that contains some
readable ASCII text. These are the contents of a single sector. At the
bottom of the screen you’ll see the Cylinder, Head, and Sector values for
the current location, followed by the physical sector or logical block
address (LBA). You can press Ctrl-G (or choose GoTo Sector/Block
from the View menu) to select a different sector to look at.

The Find feature will locate a specific text string and can help you
determine if a particular critical document is still present on the disk.
Let’s say your spreadsheet with the payroll records of your company has
Pa
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been lost. Follow these steps to determine if this spreadsheet is still on
the drive:

1. Open the Disk Viewer.

2. Select Find from the Edit menu (or press Ctrl-F).

3. Type John Doe in the Find What box. Click Find Next.

4. A Searching… box will come up and tell you what sector
is being searched. This can take some time. You can cancel the
search at any time by clicking the Cancel button.

5. If the first match for John Doe isn’t from the spreadsheet, go back to
the Edit menu and select Find Next to keep looking.

Keep in mind that if a file takes up more than one sector, there is a
possibility that the whole file cannot be recovered. If the FAT is corrupt,
and the file is fragmented (not in contiguous clusters), EasyRecovery may
not be able to locate some parts of the file.

VIEWER FORMATS

All data on a computer is in binary (Base 2) form. When displaying
binary code, the numbers get large very quickly. Programmers use
different ways to display/convert these 1s and 0s to make it convenient.
Most often they use a hexadecimal format (Base 16), because you can
represent one byte of data as two consecutive hexadecimal digits.

There are other ways to display the same data, though. The Disk Viewer
display changes depending on your Format. Go to Format from the View
menu to change this. Choose from Decimal, Octal, Word and DWord.
Changing the format will not make it easier to find a text string. To do
that, use the Find command.
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HINT BUTTON

If you only know the size of your partition, and/or aren’t comfortable
using the slider bar, use the Hint button from the first Partition Finder
screen. You can use the drop-down menu in the Partition Count line at
the top to define how many partitions are on this drive.

The second item asks you how many megabytes are on the first partition
on the drive. Be aware that a gigabyte (GB) is equal to 1024 megabytes
(MB), so a 6 GB drive has about 6144 MB.
Pa
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The last item on the Hint screen lets you select the partition you want to
scan. The drop-down menu will let you choose from the number of
partitions you specified in the Partition Count line.

Click Next to save your information and return to the Partition Finder
screen. Click Back or Cancel to return to the Partition Finder screen
without saving the changes.

IDENTIFYING A PARTITION: ADVANCED OPTIONS

You can help EasyRecovery locate your partition with this additional
information:
Page 26
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Cluster Size: Based on the file system and the size of your drive,
EasyRecovery tries to determine the size of each cluster. You can use the
drop-down menu to reset this.

First Data Sector: In its initial scan, EasyRecovery tries to locate the first
sector containing any kind of data. If the Disk Viewer tells you
something different, you can reset that here.

SCAN MODE OPTION

EasyRecovery will scan the file system for files to recover. There are two
modes to choose from:

� Typical – this is the default case and in most cases will be sufficient
to locate your missing partition. With this option, only specific areas
are searched, thus making it a relatively quick solution.

� Advanced – This option performs a much more exhaustive search for
your missing partition. Instead of searching specific areas of the
disk, the Advanced mode will check every cluster. The Advanced
mode is substantially slower, and should only be used if the typical
option fails

Click Next to confirm all the changes made in the Partition Finder screens
and begin recovery.

RECOVERING YOUR DATA

Once you’ve selected and defined your partition, EasyRecovery will scan
it and recover as many files as possible.

While EasyRecovery is scanning the partition, it will give you a
continuous progress report. You’ll see:

� The current block being processed

� A running Time Elapsed/Time Remaining count

� The total number of Directories/Folders and Files Found
Pa
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� The last file found (with size information)

� A progress bar indicating the percentage of the scan that is complete

You can hide this display (except for the progress bar) by clicking the
Hide Details button on the right side. This will improve the performance
by decreasing the amount of work that must be done to update the screen.

You can stop the recovery in mid-process by clicking the Cancel button at
the bottom. You’ll be given a choice to save the recovery information up
to that point (see the next section, “Saving Recovery Data”), or continue
Page 28
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the recovery process. To get the best results, we recommend that you
allow the recovery scan to complete.

When the recovery process is complete, you can locate and recover your
files.

SAVING RECOVERY DATA

If for some reason you need to interrupt the data recovery process,
EasyRecovery lets you save all the information it has retrieved from the
damaged drive and pick up where you left off at some later point. This
includes the information on your partition and on any files that have been
recovered.

The easiest way and best time to do this is after the recovery scan is
complete. From the main Recovery screen, click File�Save Recovery.
You’ll specify a directory to put the saved *.dat file.

If you need to interrupt the recovery process, you’ll also get the chance to
save the recovery. For best results, however, we recommend always
allowing the recovery scan to complete.

When you want to return to EasyRecovery, open the program and go to
File�Resume Recovery. Locate and open the saved *.dat file. You’ll
be returned to the same screen you were at when you saved. If a scan was
in process, it will resume there automatically, using the same parameters
you set earlier.
Pa
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Chapter 3: Copying Recovered Files

Once EasyRecovery has recovered your data, you can then choose to
copy any or all of your files to a safe location.

LOCATING AND TAGGING FILES AND DIRECTORIES

When the recovery scan is complete, EasyRecovery will show the
contents of the virtual drive in a window that looks like a file manager.
Everything in this window has been recovered from the damaged
partition, and can be copied to a safe place.
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On the left side you can see the directories and subdirectories, under "My
Drive." On the right side are the files of the selected directory.

If your root or any directory was destroyed, EasyRecovery will create
fictitious directory names. The names with be of the form dir99999 and
are referred to as "check dirs." This is done in an effort to keep the
directory tree intact. The files that were located in these damaged
directories are placed in these check dirs. Whether or not there is a "real"
name for the directory, the files are still of the same quality.

Use this screen to select the files you want to retrieve from the disk.

TAGGING FILES

Once you’ve generated the list of files that can be recovered, you tag files
to mark them for recovery. Simply check the box next to any file to tag it.

If you want to retrieve the whole drive, tag My Drive by clicking the box
on the left. A check mark will appear in the box next to all files and
folders tagged for copy. If the check is gray in color, the folder has at
least one file somewhere below it that is tagged. If the check is blue, all
files and subfolders are tagged.

As you tag files, EasyRecovery will report the number of tagged files and
their size. The more files you tag, the longer it will take to copy them.

When you’ve tagged all the files you want to recover, click Next to
complete the process.

ADVANCED TAGGING OPTIONS

Clicking the Show Tag Options button opens a number of advanced
options for mass tagging. These include:

� By name: Use wildcards to identify specific files and/or extensions.
This does not allow for multiple selections.
Pa
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� By date: Name a specific date, on, before or after.

� By size: Define a file size (in bytes) and set the flag for equal,
smaller, larger--even between two sizes.

� By condition: The Condition column in the file list notes any
problems with files it recovers. See “Assessing the Quality of a File”
on page 33. for an explanation of this column. Check the appropriate
boxes to tag by condition.

If the "Include Subdirectories" box is checked, files meeting the tagging
requirements in tagged folders will be tagged, regardless of how deep in
the file tree they go. If you have files in subfolders that you don’t want to
retrieve, you can uncheck the box(es) for those files at any time before
starting the copy.

Once you’ve tagged a set of files, you can also use the Untag option to
specify a different set of criteria and apply that set to file that have already
been tagged. Thus, you might tag a group of files larger than 500 bytes
modified since January 1, then find a number of large program update
files that are already located on another machine on the network. Simply
go back to the size menu, specify larger than 5000 bytes and click Untag.

GENERATING REPORTS

You can generate a series of reports from the Report menu. By default,
Run Report During Copy is checked. This time-stamped report contains
the location of your recovered file(s), the date each file was created, and
its size. You’ll also get the total number of files, and bytes, recovered.

You can save a list of all your tagged files (with size and date created)
before the recovery process starts. Go to Report�Run Report on
Tagged Files.

Before you run these reports, you’ll have to set a destination folder for the
report. Click Set Report Destination from the Report menu. If you
don’t do this before starting the copy operation, you’ll be prompted to do
so before the copy starts.
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SETTING THE DESTINATION FOLDER

EasyRecovery copies your file(s) to a folder on an undamaged partition.
The default is C:\Recover, but if your C drive has been damaged, you
must copy the recovered files to a different partition, preferably a
completely different physical drive. This could be another physical hard
drive, a network drive, a Zip or other removable drive, or even a floppy
(for a few small files).

To change the destination folder, select the text in the Copy Files To box
and type in the new folder path.

VIEWING THE CONTENTS OF A FILE

EasyRecovery will let you view the contents of a recovered file, much
like the Disk Viewer (see page 22). Select a file from the window and
choose View Contents from the File menu.

You can search for text or hex strings by pressing Ctrl-F or selecting
Find from the Edit menu. As in the Disk Viewer, you can also change
the format from the View menu. See “Viewer Formats” on page 24..

ASSESSING THE QUALITY OF A FILE

The condition of recovered files depends on the overall condition of the
system. EasyRecovery notes any problems with each file in the
Condition column on the recovery screen with a letter/color combination.
The key is in the chart below.

If you have more than one damaged partition on your
system, DO NOT copy files from one partition to another
damaged partition. Always use removable media (like a
Zip disk) or a second, undamaged hard drive, as the
destination in these cases.
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If a file has multiple problems, the color will reflect the most serious
problem. So a Deleted file with a bad attribute will be blue, but a deleted
cross-linked file will be red.

Always check the contents of problem files in the file viewer before you
copy.

RECOVERING FILES TO A SAFE LOCATION

When you’ve tagged your files and selected a target folder, you’re ready
to begin moving data. Click Next to begin.

EasyRecovery will copy the data to the destination folder. If you have a
large number of files, you’ll see a screen similar to the Recovery Scan
screen. It will give you a continuous progress report, with the file being
recovered, the destination and the Time Elapsed and Remaining. A
progress bar will also keep you posted on the percentage of files copied.

When your files have been copied to the destination folder, click Finish to
close EasyRecovery.

Black d File with a bad date: after today or with invalid values (e.g., 15-50-2000)

Black a Bad (undefined or invalid) attribute

Black n Bad name: has invalid characters

Blue D Deleted

Red X Invalid chain, perhaps a cross-linked file or runlist that doesn’t match its
size

Red s Bad size: file is larger than the partition (volume)
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Chapter 4: Important Terms
CLUSTER

The basic unit of data structure on a hard or floppy drive. A cluster is a
group of more than two sectors. Cluster sizes can vary from 512 bytes to
256k bytes, depending on the particular file system and the partition size.

CROSS-LINKED FILES

If your system crashed while you're saving a file, the FAT may report that
two files contain at least one like cluster on the drive. These are cross-
linked files. These are not allowed by either FAT or NTFS file systems.
NT does support hardlinks and they will not be described as cross-links.
A hardlink is simply another name (possibly in another folder) that
contains exactly the same contents.

FILE ALLOCATION TABLE

In DOS and Windows, data is stored in distinct clusters on the drive.
DOS creates a File Allocation Table (FAT) to track where each file is
stored.

FILE SYSTEM

A file system consists of files, directories, and the information needed to
locate and access these items.

PARTITION

A formatted section of your hard drive. Drives formatted by DOS or
Windows have at least one partition, labeled C:. Large drives can be
Pa
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formatted to have multiple partitions. Each partition will then behave as
if it were a separate physical drive, with its own letter (D, E, F, etc.).

SECTOR

The smallest storage units on a disk. On PCs, a sector can hold 512 bytes
of information.
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